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Quick Start Guide for bq2750x Family Gas Gauge
Ming Yu ...................................................................................... HVAL - Battery Management Solutions
ABSTRACT
This application report provides you a design process overview, procedures to use the
evaluation module and software, and helpful troubleshooting techniques.

1

2

3
4

5

6

Contents
Introduction .......................................................................................... 2
1.1
Related Documentation ................................................................... 2
1.2
Terminology ................................................................................ 3
1.3
Document Overview ....................................................................... 3
Getting Started With the bq2750x Evaluation Module ......................................... 3
2.1
Necessary Components .................................................................. 3
2.2
bq2750x EVM Board and Pin Description .............................................. 4
2.3
Download the bq2750x Evaluation Software........................................... 5
2.4
Install bq2750x Evaluation Software .................................................... 6
2.5
Install USB Drivers for EV2300 Communication ...................................... 6
2.6
EVM Connection Setup ................................................................... 6
2.7
Starting the bq2750EVM Software ...................................................... 7
2.8
bqEVSW Software Sections.............................................................. 7
Software Communication and Trouble Shooting ............................................... 8
3.1
Troubleshooting USB Communication Issues ......................................... 9
bq2750x Evaluation Software Sections ........................................................ 11
4.1
DataRam window ........................................................................ 11
4.2
Data Flash Window ...................................................................... 12
4.3
I2C Pro Window .......................................................................... 13
4.4
Calibrate Window ........................................................................ 14
4.5
bqEASY Wizard .......................................................................... 14
Creating Your Golden Image .................................................................... 15
5.1
Production Flow .......................................................................... 15
5.2
Design and Evaluation .................................................................. 16
5.3
The Gas Gauge File ..................................................................... 16
Example Procedures ............................................................................. 17
6.1
Choosing the Correct Chemistry ....................................................... 17
6.2
Resetting the Pack ....................................................................... 18
6.3
Data Logging ............................................................................. 19
6.4
Seal and Unseal Process ............................................................... 20
List of Figures

1
2
3
4
5
6
7

bq2750x Evaluation Module .......................................................................
Basic bq2750xEVM Configuration ................................................................
bq27500EVM Product Folder .....................................................................
bq2750x EVM Software Organization............................................................
bqEVSW Unable to Communicate With EV2300 ...............................................
Select bq2750x device .............................................................................
DataRAM Window displaying No EV2300 Communication ...................................

4
5
5
7
8
8
9

Impedance Track is a trademark of Texas Instruments.
Windows is a trademark of Microsoft Corporation.
SLUA448 – January 2008
Submit Documentation Feedback

Quick Start Guide for bq2750x Family Gas Gauge

1

www.ti.com

Introduction
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26

bqEVSW software shows no USB board if EV2300 is not connected ....................... 9
bqEVSW Complains if no EVM or EVM not powered up .................................... 10
DataRAM Displaying Appropriate Communication with EV2300 ........................... 11
Data Flash Window Displaying Default Parameters .......................................... 12
Data Flash Definitions Display with Right-click and Choosing Help Text .................. 12
I2C Pro Window ................................................................................... 13
Calibrate Window ................................................................................. 14
bqEASY Wizard ................................................................................... 15
Production Flow Diagram ........................................................................ 16
Gas Gauge File (Default and Cycled Values) ................................................. 17
Chemistry Selection Table in bqEASY Wizard ................................................ 18
Sending MACs - DataRAM and I2C Pro Windows ........................................... 19
DataRAM Data Logging Command ............................................................. 19
Gas Gauge Logging Setup and Start Commands ............................................ 20
Default Unseal Key and Full Access Key ...................................................... 21
Sealed Mode for the bqEVSW DataRAM window ............................................ 21
Default Unseal Command Using Control Register............................................ 22
Status Showing Unsealed Mode With Full Access FAS Bit Set ............................ 22
FAS and SS Bits are Cleared ................................................................... 23
List of Tables

1

1

bq2750x Pin/Jumper Descriptions ................................................................ 4

Introduction
The Texas Instruments bq27500/01 system-side Li-Ion battery fuel gauge is a microcontroller peripheral
that provides fuel gauging for single-cell Li-Ion battery packs. The device requires little system
microcontroller firmware development. The bq27500/01 resides on the system main board, and manages
an embedded battery (non-removable) or a removable battery pack.
The bq2750x uses a patented Impedance algorithm for fuel gauging, and provides information such as
remaining battery capacity (mAh), state-of-charge (%), run-time to empty (min.), battery voltage (mV), and
temperature (°C).
Battery fuel gauging with the bq27500 requires only PACK+ (P+), PACK– (P–), and Thermistor (T)
connections to a removable battery pack or embedded battery. The bq27501 works with identification
resistors in battery packs to gauge batteries of different fundamental chemistries and/or significantly
different rated capacities.

1.1

Related Documentation
TI recommends that you familiarize yourself with these documents before working with the Impedance
Track™ gas gauge devices.
• Quick Start Guide for bq27500/1EVM Kit (SLUU298)
• Single-Cell Impedance Track™ Gas Gauge Introduction (SLUA422)
• Key Design Considerations for the bq27500 and bq27501 (SLUA439)
• bq2750xEVM System Side Single-Cell Impedance Track™ Technology Evaluation Module (SLUU287)
• Host-side gas-gauge-system design considerations for single-cell handheld apps (SLYT285)
• Configuring the bq27500 Data Flash (SLUA432)
• bq2750x Datasheet (SLUS785)
• Using bqTester Single Site Software (SLUA352)
• bq27500 Theory and implementation of Impedance Track battery fuel-gauging algorithm (SLUA450)
• Data Flash Programming and Calibrating the bq27500 Gas Gauge (SLUA440)
• Going to Production with the bq2750x (SLUA449)
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1.2

1.3

Terminology
Acronym Description

Acronym

Description

DF

Data Flash

IT

Impedance Track™

GG

Gas gauge

MAC

Manufacturer Access Command

SENC

Firmware file (encrypted)

DFI

Data Flash Image file (binary)
with modified data

bqEASY

bq2750x programming wizard

ENCR

Data Flash file specific to a
fresh TI fuel gauge

CHEM

Chemical model files for
different LI-ion batteries

EZY

bqEASY project file

Document Overview
This document covers procedures for evaluation module setup and working with bq Evaluation Software.
Additionally, the document highlights multiple approaches to troubleshooting the software connection,
graphical user interface navigation, and key elements for the different configuration windows.
Example step-by-step procedures are described in Section 6 for:
• Choosing the correct chemistry
• Resetting the pack
• Logging data during testing
• Sealing and unsealing a pack

2

Getting Started With the bq2750x Evaluation Module
To get started with the bq2750x evaluation module (EVM), you will want to:
1. Gather all needed components
2. Acquaint yourself with the EVM board, pin descriptions, and basic EVM configuration
3. Download the bq Evaluation Software
4. Install the bq Evaluation Software
5. Install two USB drivers to communicate with the EV2300
6. Make the circuit module connections
7. Start the bq Evaluation Software
8. Become familiar with key Li-Ion battery fuel gauge software procedures

2.1

Necessary Components
To perform the bq2750x procedures described in this report, you need:
• bq2750x EVM board (HPA291) - check bq27500 Errata (SLUZ015) and bq27500 EVM (HPA291
Rev. A) Errata (SLUZ016)
• EV2300 USB PC Interface Board
• 4-colored wire set connector (I2C communication from EVM J4 to EV2300)
• USB cable (A-B type)
• NTC103AT Thermistor
• bq2750x EVM CD or latest documentation and software from the Texas Instruments Internet site
(see Figure 3)
• PC host running the Windows™ 98SE, Windows XP, or Windows 2000 operating system and an
available USB port
• Power supply or single-cell in series Li-ion battery (Li-ion battery preferred)
• Electronic load or electronic system (range 3 V to 4.2 V)
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•

2.2

Single-cell Li-ion battery charger (optional)

bq2750x EVM Board and Pin Description
Use this section to become familiar with the bq2750xEVM module, pin/jumper descriptions, and the basic
EVM configuration.
Figure 1. bq2750x Evaluation Module

Table 1. bq2750x Pin/Jumper Descriptions
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PIN NAME / Jumper

DESCRIPTION

PACK+ (J8)

Pack positive terminal

PACK– (J8)

Pack negative terminal

T

Pack thermistor input

NC/RID

Pack resistor ID input (only for bq27501)

SDA (J4)

I2C communication data line

SCL (J4)

I2C communication clock line

VSS (J4)

Signal return for communication line; shared with charger and
ground

CHARGER+/LOAD+ (J7)

Power for load or charger connection

CHARGER–/LOAD– (J6)

Ground for load or charger connection (system VSS)

BAT_LOW

Access to push-pull output that signals low state-of-charge

BAT_GD

Access to open drain output indicating pack is ready to connect to
the EVM

BI_OUT

Battery-Insertion detection input. Power pin for pack thermistor
network.
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Figure 2. Basic bq2750xEVM Configuration

2.3

Download the bq2750x Evaluation Software
This software is included with the EVM on a CD or can be downloaded from the evaluation module
product folder (use the Part Number bq27500EVM as the search keyword) from www.TI.com. Figure 3
displays the portion of the Internet page with the EVM software link named: bq27500 EVSW installation
File.
Figure 3. bq27500EVM Product Folder
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2.4

Install bq2750x Evaluation Software
Note:

Before you install the bq2750xEVM software, make sure the EV2300 communication box is
disconnected from the PC Host.

Using the CD included with the bq2750xEVM or the zip file you downloaded from the TI Internet site:
1. {Download only) Unzip the SLUC082.zip file to a temporary directory.
2. In your temporary directory (or the EVM CD), browse for the preliminary software installation file with
the generic name: bqEV-EASY-HH SWSetup00.XX.yy_bq27500v1.00_bqEasyvz.zz.exe, where
XX=major preliminary number, yy=minor preliminary number, and z.zz= version number.
3. Double-click and follow the standard installation instructions; accept license agreement, choose folder,
and display Readme file.

2.5

Install USB Drivers for EV2300 Communication
Note:

Before installing the USB drivers, use the supplied USB cable to connect the EV2300 to the
computer that has the bq2750x evaluation software installed.

Installing the driver for the EV2300 communication box requires you to install two USB drivers for proper
operation. Complete instructions for installing the USB drivers can be found in the EV2300 Driver to USB
Port Association section of the Using bqTester Single Site Software document (SLUA352).
Briefly, the required steps are:
1. When the operating system prompts you with a Found New Hardware Wizard, Choose the No, not at
this time option.
2. On the next screen, select the Install from a list or specific location option and use the Browse button
to navigate to the PC Host folder (XP system): C:\Windows\TI\USB1
3. Respond Continue Anyway to the warning that drivers are not certified by Microsoft.
You have successfully installed the TI USB Firmware Updater.
4. Once again, the operating system prompts you with a Found New Hardware Wizard, Choose the No,
not at this time option.
5. On the next screen, select the Install from a list or specific location option and use the Browse button
to navigate to the PC Host folder (XP system): C:\Windows\TI\USB2
6. Respond Continue Anyway to the warning that drivers are not certified by Microsoft.
You have successfully installed the TI USB bq2750x Driver.

2.6

EVM Connection Setup
Refer to Figure 2 when performing the EVM setup:
1. Connect one side of the 4-wire-set connector to the EV2300’s I2C port (black wire aligned with GND
pin) and the other side to the board's J4 connector (black wire aligned with the VSS pin).
2. Ensure that jumper in J5 of board is connected at the bottom position as shown Figure 2.
3. Ensure that NTC103AT thermistor is connected to the T and PACK– terminals of the J8 block of the
board.
4. Ensuring proper polarity, connect the 3-V to 4.2-V power supply or single-cell Li-ion battery between
the PACK+ and PACK– terminals (J8) of the board.
5. To see current measurements, apply a load to J7 and J6 board connectors.
Note:

J6 is for host or charger ground and J7 is for host or charger power.

6. To properly configure the fuel gauge IC for a given application, proceed to the bqEASY area of the
evaluation software (Section 4.5) and the bq2750x EVM User's Guide (SLUU287).
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For detailed instructions on operating the fuel gauge system, see the bq2750x Datasheet (SLUS785) and
the bq2750xEVM System Side Single-Cell Impedance Track™ Technology Evaluation Module User's
Guide (SLUU287).

2.7

Starting the bq2750EVM Software
Beginning at the Windows Start menu, start the bq27500x evaluation software by selecting the application
from the cascading menus: start → Programs → Texas Instruments → bq Evaluation Software. To
become familiar with the bq2750x evaluation module (EVM) you can simulate a battery cell with resistors
and a power supply. You can vary the voltage across these resistors to simulate different states of charge.
This configuration is shown in Figure 2 and described in the bq2750xEVM System Side Single-Cell
Impedance Track ™ Technology Evaluation Module application note (SLUU287).

2.8

bqEVSW Software Sections
The bq2750x evaluation software uses five major sections (Figure 4):
• DataRAM—standard I2C information you can read from the pack when it is sealed and important IC
status registers.
• Data Flash—shows all the parameters you can change when designing your system. Because this
multiple-dialog window contains so much information, you can right-click the mouse to display a Help
pop-up window that describes each value name.
• I2C Pro—reads and writes data from any gas gauge, plus can also load a new firmware file.
• Calibrate—performs temperature, coulomb counter (CC) input, board current, and pack current
calibration tests.
• bqEASY—software wizard that acts like a workflow to simplify the configuring, chemistry selection, and
performing learning cycles needed to produce the final "golden image" file.
Figure 4. bq2750x EVM Software Organization

A

Check box to Keep Scanning while you make changes.

B

Switches you quickly between major software areas.

C

Area provides information on Communication status, device type, and firmware version number.
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Software Communication and Trouble Shooting
When you start the bq2750x EVM software (bqEVSW), it should automatically recognize the firmware and
hardware version. If there is a EV2300 USB PC Interface board communication problem, the message in
Figure 5 displays.
Figure 5. bqEVSW Unable to Communicate With EV2300

Click OK and the software requests you to choose a device in use. If you get to this point, you are not
going to have proper communication with the EVM.
Figure 6. Select bq2750x device

If you choose one of the devices and firmware revisions, you eventually can display the DataRAM window;
however key flags and status bits are grayed-out (Figure 7). The bq2750x EVM software uses color codes
to describe the current status for the DataRam Flags and Status bits. Please familiarize yourself with the
legend in Figure 4 and Figure 10.
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Figure 7. DataRAM Window displaying No EV2300 Communication

3.1

Troubleshooting USB Communication Issues
If you are having EVM communication issues, try these steps:
•
•
•
•
•
•

Do you have the EV2300 USB cable connected (Figure 8) as shown in the Basic bq2750xEVM
Configuration?
Have you properly installed the required TI USB Firmware Updater and the TI USB bq2750x drivers,
as discussed in Install USB Drivers for EV2300 Communication?
Did you kick start the EVM by connecting power momentarily to PACK+ and PACK– to simulate a
charger insertion?
Are the I2C lines connected to the EVM (Figure 2)?
Is there another instance of the software already running? Press Cntl+Alt+Delete keys to display the
Task Manager and look for another instance of the bq2750x EVM software (bqEVSW) running.
Try restarting your computer if you do not see the TI USB bq2750x driver displayed in the System
Properties → Hardware dialog tab → Device Manager window.
Figure 8. bqEVSW software shows no USB board if EV2300 is not connected
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Figure 9. bqEVSW Complains if no EVM or EVM not powered up
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4

bq2750x Evaluation Software Sections
The DataRAM screen displays as the default window, providing you access to the context-sensitive help
and the five windows used to organize the software GUI controls:
• DataRAM
• Data Flash, with context-sensitive (right-mouse) help
• I2C Pro
• Calibrate
• bqEASY Wizard

4.1

DataRam window
If everything is working OK, a DataRAM window similar to Figure 10 displays with green/orange indicators
in the status registers. Also, Communication OK will be in the lower left-hand corner. Click on the Keep
Scanning box at the top of the window. The software will keep updating these values throughout your
testing process.
The DataRAM window shows the standard I2C information you can read from the pack when it is sealed,
as well as showing important status registers on the IC which can only be seen when the pack is unsealed
or in full access mode (no FAS or SS bit set in Control Status register). By default, the IC is configured in
full access mode.
Figure 10. DataRAM Displaying Appropriate Communication with EV2300

You can issue Manufacture Access commands (MAC) from this window by clicking in the Control field
under the Value column (see Issuing MACs procedures ). For example, this issue arises when writing the
Unseal or Full Access commands. Examples of how to complete these processes is included in Seal and
Unseal Process.
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4.2

Data Flash Window
The Data Flash window (Figure 11) shows all the parameters you can change when designing your
system. To begin, you can load the default values stored which shows the single cell pack configuration.
For detailed information on configuring the Data Flash for your particular design, see Configuring the
bq27500 Data Flash (SLUA432)—a comprehensive resource for all Data Flash parameters.
Figure 11. Data Flash Window Displaying Default Parameters

Remembering all the nuances of the Data Flash parameters is not practical. However, all of the Data
Flash definitions are listed in the bq2750x Technical Reference Manual. Additionally, you can right-click on
any Data Flash parameter and choose Help Text (Figure 12), which displays an appropriate definition.
Figure 12. Data Flash Definitions Display with Right-click and Choosing Help Text
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4.3

I2C Pro Window
The I2C Pro window helps you communicate with bq2750x IC. It is here where you can read and write
byte, work, and block information. Also, you can upload a new .SENC file from this window by following
the steps in the Data Flash Programming and Calibrating the bq27500 Gas Gauge (SLUA440).
Figure 13. I2C Pro Window
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4.4

Calibrate Window
The Calibrate window (Figure 14) helps you calibrate gas gauge voltage, current, temperature, and
offsets. See similar procedures in the Data Flash Programming and Calibrating the bq27500 Gas Gauge
(SLUA440).
Figure 14. Calibrate Window

4.5

bqEASY Wizard
The bqEASY window (Figure 15) is a new feature in the bq Evaluation Software, used to program the
Data Flash parameters, choose the proper battery chemistry, and perform the two cycle tests to create
your Golden Image. If you are new to the Impedance Track™ technology, this is a great way to have a
structured workflow to follow. (See details in Production Flow section.)
The bqEASY Wizard uses data entry dialogs to gather information and perform production tasks:
1. Setup—Impedance Track Configuration Wizard Splash screen
2. Configure—choose Data Flash parameters
a. Cell Characteristics
b. Charge Parameters
c. Discharge Parameters
d. Reserve Capacity
e. Load Characteristics
f. Application Configuration
g. Remaining Capacity Method
h. Miscellaneous Information
3. Calibrate
a. CC Offset
b. Voltage
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c. Temperature
d. Pack Current
e. Board Offset
f. Review / Read DFI file
4. Chemistry
a. Use Default Chemistry
b. Select Chemistry Manually
c. Do Chemistry Select Cycling
5. Cycle
a. Learning Cycle
b. Update Golden Pack
Figure 15. bqEASY Wizard

5

Creating Your Golden Image
One of the major benefits of using the Impedance Track technology, aside from super accurate gas
gauging, is a simplified manufacturing process. No charge or discharge cycles are required after
assembling the pack, which can take many hours.

5.1

Production Flow
Figure 16 is a procedure diagram showing the normal production flow of the bq2750x chipset. A detailed
description of these states can be found in the Going to Production with the bq27500 application report
(SLUA449).
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Figure 16. Production Flow Diagram

These are different steps in design, preproduction, and production.

5.2

Design and Evaluation
1. Install the bqEVSW software and EV2300 communication USB drivers.
2. Connect resistors and power supply to simulate battery pack.
3. "Kick-start" the EVM (connect power momentarily to the PACK+ and PACK– to simulate charger
insertion).
4. Start bqEVSW software
5. Explore the different features of the software.
6. Load the correct .chem file corresponding to the chemistry of your battery cells using the bqEASY
wizard (see Choosing the Correct Chemistry).
7. Program the necessary Data Flash constants specific to your design.
8. Connect a real battery cell to the EVM
9. Fully charge the cells and let reset for 2 hours.
10. Start Data Logging – both DataRAM parameters and the .GG gas gauge files.
11. Repeat these steps as often as necessary:
• Enable Impedance Track Algorithm
• Discharge Pack to termination voltage and let reset.
• Repeat this process
12. Look for updated resistances and Update Status = 02 in the final .GG file.
Once you have a properly cycled pack with updated values, we need to create a Golden image file that
is programmed and incorporated into every pack coming off the production line.
13. Export the .GG file and make a few changes (disable IT and change cycle count to 0).
14. Reload the .DFI file to clear out Data Flash hidden values.
15. Import your changed .GG file.
16. Now you are ready to create the .DFI file used to program production packs.

5.3

The Gas Gauge File
The Gas Gauge (.GG) file stores all programmable Data Flash parameters as well as the updated cell
resistance profile after doing the two cycle tests. Figure 17 displays a gas gauge file, showing its default
values (specific to this chemistry) and it's updated values after the cycle tests.

16
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Figure 17. Gas Gauge File (Default and Cycled Values)

(1)

Update Status as changed from 0x00 to 0x02

(2)

QMAX for the individual cells and pack has been updated

(3)

Resistance table (Ra Table) updated for each of the cells.

6

Example Procedures

6.1

Choosing the Correct Chemistry
For the impedance track algorithm to work properly, the exact chemistry of the Lithium cells needs to be
known and the correct .SENC file needs to be loaded.
The most updated chemistry files can be found installing the latest version of the bqEVSW software, which
you found on the TI Internet site in the bq2750x Product Folder (Figure 3). The files are stored in the
folder named: C:\Program FIles\Texas Instruments\bq Evaluation Software\Plugins\Chemistry The
Chem.ini file describes the chemistry, manufacturer, and model numbers for the *.CHEM files in this
folder.
You can use the bqEASY wizard (Figure 18) to display the chemistry information in an easy-to-use and
organized manner. If you are using the bqEASY Wizard, it asks you to choose the correct chemistry from
a list of manufacturers and model numbers. Alternatively, you can test for a compatible chemistry using a
4 point test.
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Figure 18. Chemistry Selection Table in bqEASY Wizard

A unique chemical ID indicates a different battery chemistry being used.

6.2

Resetting the Pack
Vary the voltage of the power supply (careful not to exceed maximum voltages) and issue a RESET
Manufacture Access Command (MAC) to the bq2750x. The I2C double-word command is 0x00, data
0x0041.
There are two ways to do this (see Figure 19). The shortcut is to type 41 into the Manufacture Access
Value of the DataRAM window. Alternatively, use the I2C Pro window to issue a reset command 00, data
4100 from the Write I2C Data Block and click the Write Data button.

18
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Figure 19. Sending MACs - DataRAM and I2C Pro Windows

6.3

Data Logging
While you are running your charge and discharge tests you may want to log the DataRAM and gas gauge
(.GG) flash data. This is done in two steps. The DataRAM data is logged by selecting the File →
Start Logging menu command (Figure 20). The Save As (Log File Name) dialog asks what folder and
what file name to use for the Log File.
Figure 20. DataRAM Data Logging Command

To save the iterations of the Gas Gauge (.GG) file, go to the Data Flash window and select the
Options → Set AutoExport Filename command. A series of Gas Gauge files is created in the folder
specified throughout the testing. You can adjust the save interval of AutoExport (every 15 minutes is
usually acceptable) using the Options → Set Export Interval command. To start the logging, select the
Options → AutoExport command (Figure 21) to begin saving the Gas Gauge files.
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Figure 21. Gas Gauge Logging Setup and Start Commands

6.4

Seal and Unseal Process
Once you are finished with the production flow (see Figure 16) and have programmed the correct gas
gauge (.gg) file for your "golden pack", you will want to seal the pack. If you do seal the pack, you can
issue the Unseal command, followed by the Full Access command to make changes. However, if you
removed power to IC, it returns to sealed mode and you would have to repeat this process again to unseal
and subsequently move to full access mode. The only way to reset the IC to automatically come up in full
access mode is to reload the .SENC file with defaults.
Note:

Be careful when reloading the .SENC file as it can erase any Data Flash constants or
resistance updates through cycling that you may have made.

If you Seal your battery pack and later you decide to unseal it (for example, diagnosing a field failure), you
must perform these steps to move from Sealed, to Unsealed, and finally to Full Access mode.
1. During production, you will want to change the default Unseal and Full Access Keys settings in the IC.
To read the default Unseal and Full Access Key, the data flash portion of the device needs to be
opened by the configuration file .encr and the Security dialog tab (Figure 22) can be accessed. The
default Unseal Key and Full Access Key can be modified.
2. When the IC is sealed, and you connect the EV2300 and start the bq2750x evaluation software, the
DataRAM window displays as in Figure 23. (Not all the status registers are accessible. These are
grayed out in the DataRAM window.) Sealing the pack is done using Manufacture Access 0x0020.
Note:

Do not seal your pack until after production.

3. The FAS (Full Access Seal Mode) and SS (Sealed State) bits are set when seal command is issued
through control register. To move from Sealed to Unsealed mode, write to the bq2750x device with the
UNSEAL Key (04from the previous step. After this command is issued you are able to read all the
status registers, as shown in Figure 25. We still need to move from Unsealed to Full Access mode
using the FullAccessKey.
Note:

The SS bit (Sealed) is cleared; however the FAS bit (Full Access) is still set in Figure 25.

4. After issuing the two 0xFFFF Full Access Key through control register, the FAS bit (Figure 26) is also
cleared.
20

Quick Start Guide for bq2750x Family Gas Gauge

SLUA448 – January 2008
Submit Documentation Feedback

www.ti.com
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Figure 22. Default Unseal Key and Full Access Key

Figure 23. Sealed Mode for the bqEVSW DataRAM window
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Figure 24. Default Unseal Command Using Control Register

Figure 25. Status Showing Unsealed Mode With Full Access FAS Bit Set
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Figure 26. FAS and SS Bits are Cleared
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specifications. Buyers acknowledge and agree that any such use of TI products which TI has not designated as military-grade is solely at
the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in connection with such use.
TI products are neither designed nor intended for use in automotive applications or environments unless the specific TI products are
designated by TI as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-designated
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